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Abstract

These Application Notes describe the procedures for configuring Intermedia Session Initiation
Protocol (SIP) Trunking using TLS/SRTP with Avaya IP Office Release 9.1 and Avaya
Session Border Controller for Enterprise Release 7.0.

Intermedia SIP Trunking provides PSTN access via a SIP trunk between the enterprise and the
Intermedia network as an alternative to legacy analog or digital trunks. This approach
generally results in lower cost for the enterprise.

Readers should pay attention to Section 2, in particular the scope of testing as outlined in
Section 2.1 as well as the observations noted in Section 2.2, to ensure that their own use cases
are adequately covered by this scope and results.

Intermedia is a member of the Avaya DevConnect Service Provider program. Information in
these Application Notes has been obtained through DevConnect compliance testing and
additional technical discussions. Testing was conducted via the DevConnect Program at the
Avaya Solution and Interoperability Test Lab.
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1. Introduction

These Application Notes describe the procedures for configuring Session Initiation Protocol (SIP)
Trunking between service provider Intermedia and an Avaya IP Office solution using TLS/SRTP. In
the sample configuration, Avaya IP Office solution consists of an Avaya IP Office 500v2 release
9.1.6, Avaya Session Border Controller for Enterprise release 7.0.1 (Avaya SBCE), Avaya
Voicemail Pro, Avaya IP Office Softphone, and Avaya H.323, SIP, digital, and analog endpoints.

The Intermedia SIP Trunking service referenced within these Application Notes is designed for
business customers. The service enables local and long distance PSTN calling via standards-based
SIP trunks as an alternative to legacy analog or digital trunks, without the need for additional TDM
enterprise gateways and the associated maintenance costs.

2. General Test Approach and Test Results

The general test approach was to configure a simulated enterprise site using Avaya IP Office to
connect to Intermedia SIP Trunking service in TLS/SRTP via Avaya SBCE. This configuration
(shown in Figure 1) was used to exercise the features and functionality tests listed in Section 2.1.

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. The
jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent to
the interoperability of the tested products and their functionalities. DevConnect Compliance Testing
is not intended to substitute full product performance or feature testing performed by DevConnect
members, nor is it to be construed as an endorsement by Avaya of the suitability or completeness of
a DevConnect member’s solution.

2.1. Interoperability Compliance Testing
A simulated enterprise site with Avaya IP Office was connected to Intermedia SIP Trunking service

via Avaya SBCE. To verify SIP trunking interoperability, the following features and functionality
were exercised during the interoperability compliance test:

e Response to SIP OPTIONS queries.

e SIP trunk registration with service provider.

e Incoming PSTN calls to various phone types. Phone types included H.323, SIP, digital, and
analog telephones at the enterprise. All inbound PSTN calls were routed to the enterprise
across the SIP trunk from the service provider.

e Outgoing PSTN calls from various phone types. Phone types included H.323, SIP, digital,
and analog telephones at the enterprise. All outbound PSTN calls were routed from the
enterprise across the SIP trunk to the service provider.

e Inbound and outbound PSTN calls to/from Avaya IP Office Softphone.

e Inbound and outbound long holding time call stability.

e Various call types including: local, long distance, international, outbound toll-free, operator
service and directory assistance.

e Codec G.711MU and G.729.

e Caller number/ID presentation.
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e Privacy requests (i.e., caller anonymity) and Caller ID restriction for inbound and outbound
calls.

e DTMF transmission using RFC 2833.

e Voicemail navigation for inbound and outbound calls.

Telephony features such as hold and resume, transfer, and conference.

Fax G.711 Pass Through modes.

Off-net call forwarding.

Twinning to mobile phones on inbound calls.

Avaya Communicator for Web (WebRTC).

Remote Worker which allows Avaya SIP endpoints to connect directly to the public Internet as

enterprise phones.

Note:

1. Remote Worker and Avaya Communicator for Web (WebRTC) were tested as part of this
solution. The configuration necessary to support remote worker and Avaya Communicator for Web
is beyond the scope of these Application Notes and are not included in these Application Notes. For
these configuration details, see Reference [8] and Reference [9] respectively.

2.2. Test Results
Intermedia SIP Trunking passed compliance testing.

Items not supported or not tested included the following:

Inbound toll-free is supported but was not tested as part of the compliance test.
T.38 Fax is not supported.

Operator Call (dial 0) and Operator Assisted (dial 0+10digits) are not supported.
SIP OPTIONS sent by Intermedia is not supported.

Intermedia does not support SIP Diversion Header.

Call Redirection using SIP REFER is not supported by Intermedia.

Interoperability testing of Intermedia SIP Trunking was completed with successful results for all test
cases with the exception of the observations/limitations described below.
¢ Intermedia does not send SIP OPTIONS message but responded to SIP OPTIONS message.

2.3. Support

For technical support on the Avaya products described in these Application Notes, visit
http://support.avaya.com.

For technical support on Intermedia SIP Trunking, contact Intermedia at https://www.intermedia.net
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3. Reference Configuration

Figure 1 below illustrates the test configuration. The test configuration shows an enterprise site
connected to the Intermedia SIP Trunking service via Avaya SBCE through the public IP network.
For confidentiality and privacy purposes, actual public IP addresses used in this testing have been
masked out and replaced with fictitious IP addresses throughout the document.

Located at the enterprise site is an Avaya IP Office Server Edition with IP Office 500v2 as
expansion which provides connections for 16 digital stations and the extension PHONE 8 card which
provides connections for 8 analog stations to the PSTN as well as 64-channel VCM (Voice
Compression Module) for supporting VoIP codecs. The LAN port of Avaya IP Office is connected
to the enterprise LAN while the WAN port is connected to the public IP network. Endpoints include
an Avaya 9600 Series IP Telephone (with H.323 firmware), Avaya 11x0 Series IP Telephone (with
SIP firmware), an Avaya 9508 Digital Telephones, an Avaya Symphony 2000 Analog Telephone
and an Avaya IP Office Softphone. A separate Windows OS PC runs Avaya IP Office Manager to
configure and administer Avaya IP Office.

Mobility Twinning is configured for some of Avaya IP Office users so that calls to these user phones
will also ring and can be answered at the configured mobile phones.
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Figure 1: Test Configuration for Avaya IP Office with Intermedia SIP Trunking Service
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For the purposes of the compliance test, Avaya IP Office users dialed a short code of 6 + N digits to
send digits across the SIP trunk to Intermedia. The short code of 6 was stripped off by Avaya IP
Office but the remaining N digits were sent unaltered to Intermedia. For calls within the North
American Numbering Plan (NANP), the user would dial 11 (1 + 10) digits. Thus for these NANP
calls, Avaya IP Office would send 11 digits in the Request URI and the To field of an outbound SIP
INVITE message. It was configured to send 10 digits in the From field. For inbound calls,
Intermedia SIP Trunking sent 10 digits in the Request URI and the To field of inbound SIP INVITE
messages.

4. Equipment and Software Validated

The following equipment and software/firmware were used for the sample configuration provided:

Avaya Telephony Components

Equipment Release
Avaya IP Office Server Edition 9.1.600.153
Avaya IP Office 500v2 (Expansion) 9.1.600.153
Avaya IP Office Manager 9.1.600.153
Avaya Voicemail Pro for IP Office 9.1.600.153
Avaya Application Server 9.1.600.153
Avaya Session Border Controller for 7.0.1-03-8739
Enterprise (running on Portwell CAD-0208
platform)
Avaya 11x0 IP Telephone (SIP) SIP11x0e04.04.18.00
Avaya 9621G IP Telephone (H.323) Avaya one-X® Deskphone Edition S9621
Avaya Communicator for Windows 2.0.3.40
Avaya Communicator for Web (WebRTC) 1.0.16.1217
Avaya Digital Telephone (9508) 0.45
Avaya Symphony 2000 Analog Telephone N/A

Intermedia SIP Trunking Service Components

Component Release
Intermedia SBC 16.14.2
Intermedia Softswitch 16.14.2

Note: Compliance Testing is applicable when the tested solution is deployed with a standalone IP
Office 500 V2 and also when deployed with all configurations of IP Office Server Edition without
T.38 Fax Service.
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5. Configure IP Office

This section describes the Avaya IP Office configuration to support connectivity to Intermedia SIP
Trunking service through Avaya SBCE. Avaya IP Office is configured through Avaya IP Office
Manager PC application. From a PC running Avaya IP Office Manager application, select Start 2>
Programs - IP Office > Manager to launch the application. Navigate to File 2 Open
Configuration, select the proper Avaya IP Office system from the pop-up window, and log in with
the appropriate credentials. A management window will appear similar to the one shown in the next
section. The appearance of IP Office Manager can be customized using the View menu. In the

screens presented in this section, the View menu was configured to show the Navigation pane on the

left side, the Group pane in the center, and the Details pane on the right side. These panes will be
referenced throughout the Avaya IP Office configuration. Proper licensing as well as standard
feature configurations that are not directly related to the interface with the service provider (such as
LAN interface to the enterprise site and IP Office Softphone support) is assumed to be already in

place.

5.1. LAN Settings

In the sample configuration, IPO SP was used as the system name and the WAN port was used to
connect Avaya IP Office to the public network. The LAN2 settings correspond to the WAN port on

Avaya IP Office.

To access the LAN settings, first navigate to System (1) = IPO SP in the Navigation and Group
Panes and then navigate to the LAN2 - LAN Settings tab in the Details Pane.

e Set the IP Address field to the IP address assigned to the IP Office WAN port.

e Set the IP Mask field to the mask used on the public network.

e All other parameters should be set according to customer requirements.
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Select the Vol P tab as shown in the following screen.

e The H323 Gatekeeper Enable box is checked to allow the use of Avaya IP Telephones
using the H.323 protocol, such as 9600-Series IP Telephones used in the sample

configuration.

e The SIP Trunks Enable box must be checked to enable the configuration of SIP trunks to

Intermedia.

e The SIP Registrar Enable box is checked to allow IP Office Softphone usage.

e The Layer 4 Protocol, check the TLS box and set TLS Port to 5061.
e The Keepalives, select RTP-RTCP for Scope and Enabled for Initial keepalives from pull

down menus respectively.
e Periodic timeout is 30.

e All other parameters should be set according to customer requirements.

e Click OK.
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On the Network Topology tab in the Details Pane, configure the following parameters:

e Select the Firewall/NAT Type from the pull-down menu that matches the network
configuration. No firewall or network address translation (NAT) device was used in the
compliance test as shown in Figure 1, so the parameter was set to Open Internet. With this
configuration, STUN will not be used.

e Set Binding Refresh Time (seconds) to 60. This value is used as one input to determine the
frequency at which IP Office will send SIP OPTIONS messages to the service provider.

e Set Public IP Address to the IP address of IP Office WAN port. Public Port TLS is set to

5061.

e All other parameters should be set according to customer requirements.

e Click OK.
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In the compliance test, the LAN1 interface was used to connect IP Office to the enterprise site IP
network. The LANL1 interface configuration is not directly relevant to the interface with Intermedia
SIP Trunking service, and therefore is not described in these Application Notes.
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5.2. System Telephony Settings

Navigate to the Telephony - Telephony Tab in the Details Pane.

e Choose the Companding Law typical for the enterprise location. For North America, ULAW
IS used.

e Uncheck the Inhibit Off-Switch Forward/Transfer box to allow call forwarding and call
transfer to the PSTN via the service provider across the SIP trunk.

e Uncheck the Drop External Only Impromptu Conference box to allow the host of 3 way
conference leaving the active call without forcing all the parties off the conference.

e Other parameters are left at default.

e Click OK.
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5.3. Twinning Calling Party Settings

When using twinning, the calling party number displayed on the twinned phone is controlled by two

parameters. These parameters only affects twinning and do not impact the messaging or operation of

other redirected calls such as forwarded calls. The first parameter is the Send original calling party

information for Mobile Twinning box on the System = Twinning tab. The second parameter is

the Send Caller ID parameter on the SIP Line form (shown in Section 5.5).

e For the compliance testing, the Send original calling party information for Mobile
Twinning as shown below was unchecked. There is no requirement to use this parameter in
this testing configuration.

e Click OK.
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5.4. VoIP Security Settings

When enabling SRTP on the system, the recommended setting is Best Effort. In this scenario, IP
Office uses SRTP if supported by the other end, and otherwise uses RTP. If the Enforced setting is

used, and SRTP is not supported by the other end, the call is not established.

Individual SIP lines and extensions have media security settings that can override system level
settings. This can be used for special cases where the trunk or extension setting must be different

from the system settings.

In the compliance testing, Best Effort is set at system level and extensions. Enforce is set at trunk
level to ensure the secured communication over the public internet using both signaling (TLS) and
media (SRTP). Navigate to System = VoIP Security tab and configure as follow:
e Select Best Effort for Media Security. Media security is preferred. Attempt to use secure
media first and if unsuccessful, fall back to non-secure media within Avaya IP Office system.
e Other parameters are left as default.

e Click OK.
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5.5. Administer SIP Line

A SIP line is needed to establish the SIP connection between IP Office and Intermedia SIP Trunking
service. The recommended method for configuring a SIP Line is to use the template associated with
these Application Notes. The template is an .xml file that can be used by IP Office Manager to create
a SIP Line. Follow the steps in Section 5.5.1 to create the SIP Line from the template.

Some items relevant to a specific customer environment are not included in the template or may
need to be updated after the SIP Line is created. Examples include the following:
e |P addresses.
SIP Credentials (if applicable).
SIP URI entries.
Setting of the Use Network Topology Info field on the Transport tab.

Therefore, it is important that the SIP Line configuration be reviewed and updated if necessary after
the SIP Line is created via the template. The resulting SIP Line data can be verified against the
manual configuration shown in Sections 5.5.2.

Also, the following SIP Line settings are not supported on Basic Edition:
e SIP Line — Originator number for forwarded and twinning calls.
e Transport — Second Explicit DNS Server.
e SIP Credentials — Registration Required.

Alternatively, a SIP Line can be created manually. To do so right-click Line in the Navigation Pane
and select New - SIP Line, then follow the steps outlined in Sections 5.5.2.

5.5.1. Create SIP line from Template

1. Copy the template file to the computer where IP Office Manager is installed. Rename the
template file to AF_Intermedia_SIPTrunk.xml. The file name is important in locating the
proper template file in Step 5.

2. Verify that template options are enabled in IP Office Manager. In IP Office Manager,
navigate to File > Preferences. In the IP Office Manager Preferences window that appears,
select the Visual Preferences tab. Verify that the box is checked next to Enable Template
Options. Click OK.

" IP Office Manager Preferences [ili:—hj

| Preferences 1 Directories | Discovery |: Visual Preferences || Security i Validation |

Icon Size lSmall 5

[¥] Multiline Tabs
[¥/] Enable Template Opticons

[¥] Enable Template Creation

i OK ‘ ‘ Cancel ’ ‘ Help
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3. Import the template into IP Office Manager.
From IP Office Manager, select Tools = Import Templates in Manager. This action will
copy the template file into the IP Office template directory and make the template available
in the IP Office Manager pull-down menus in Step 5. The default template location is
C:\Program Files\Avaya\lIP Office\Manager\Templates.

" Zvaya IP Office Manager for Server Edition IPOSE VML [.1.600.153] ==
Fle Edit View | Tooks Help
1 & g Bxtension Renumber_.
[POSE VML Sport y -
= o < Serves Edition Service User Management
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=R BOOTP(5)
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=<3 Solution S e umildeephony|DkectmySevices System Events | SMTP | SMDR | Twinning | Codecs
=4 User37) == Ty z S :
2 Groupll) Import Templates in Manager POSEVML Loczie United States (US English}
= 9% Short Code(é5) Location <None>
= Directory(ll)
7 Time Profiefl) Contact Information

In the pop-up window that appears (not shown), select the directory where the template file
was copied in Step 1. After the import is complete, a final import status pop-up window will
appear (not shown) stating success or failure. Then click OK (not shown) to continue. If
preferred, this step may be skipped if the template file is copied directly to the IP Office

template directory.

4. To create the SIP Trunk from the template, right-click on Line in the Navigation Pane, then
navigate to New = New SIP Trunk from Template.

Fle Edt View Tools Help
 IE A v
IPOSE VML

" Avays IP Office Manager for Server Edition IPOSE VML [3.1 500153]

s

- 19 -

~ Line

| Configuration

SIP Line - Line 19

£~ POSEVMI

» | SIP Line Transport P URI VolP | S Credentisls| S2 Advanced Engineering

»
2]

MNew SIP Trunk from Template

- I ot

~ 152

#-<= Cont 7%
-4 Bden

# 3 Use x

%% Grou

-9 Short

D Servin

=€ Incor

Copy
& -
Delete

Vahdate

Create SIP Trunk Template

New from Templzte (Binary}

Export as Template {Binary)

terop-ex.sea.accessine.com
i 5

Fioud -

Ci=X
C+C

Curi=Del

== Directory 0}
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5. In the subsequent Template Type Selection pop-up window, select Intermedia from the
Service Provider pull-down menu as shown below. These values correspond to parts of the
file name (AF_Intermedia_SIPTrunk.xml) created in Step 1. Click Create new SIP
Trunk to finish creating the trunk.

™ Tem plate Type Selection E =] @
Locale United States (US English)
Service Provider | Intermedia v| Display Al
[ Create new SIP Trunk | | Cancel |

6. Once the SIP Line is created, verify the configuration of the SIP Line with the configuration
shown in Sections 5.5.2.

Note: Windows 7 (and later) locks the Avaya IP Office 9.1 \Templates directory, and it
cannot be viewed. To enable browsing of the \Templates directory, open Windows Explorer,
navigate to C:\Program Files\Avaya\lP Office\Manager\Templates (or C:\Program Files
(x86)\Avaya\lP Office\Manager\Templates), and then click on the Compatibility files option
shown below. The \Templates directory and its contents can then be viewed.
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5.5.2. Create SIP Line Manually
To create a SIP line, begin by navigating to Line in the left Navigation Pane, then right-click in the
Group Pane and select New - SIP Line. On the SIP Line tab in the Details Pane, configure the
parameters as shown below:
e Set ITSP Domain Name to the enterprise domain so that IP Office uses this domain as the
host portion of SIP URI in SIP headers such as the From header.
e Set Send Caller ID to None.
e Check the In Service box.
e Check the Check OOS box. With this option selected, IP Office will use the SIP OPTIONS
method to periodically check the SIP Line.
e Incoming Supervised REFER was set to Never as Intermedia does not support REFER.
e Outgoing Supervised REFER was set to Never as Intermedia does not support REFER.
e Other parameters are set as default values.

e Click OK.
© POSE VM1 SP Line Transpont | SIP URL VolP | SIP Ceederttiohs | SIP Advanced | Engineering
¥ Symtem (1)
= POSEVML Lire Number 19 In Service J
4 Line (5)
1 TSP Domain Name interop-ex.ted.accesslne com Check 005 v
- 5
W 10 =l Type P = Sevvion Timers
- 11
- 10 Location Cloud - Refresh Method Auto
Centrol Urst {5) Times {zeconds) On Demand
{ & Edension (22)
il User(22)
& Group M) Prefin Forwarding and Twinmeng
+-9% Sheet Code (38) Ovings >
Service ) Naticnal Prefu 0 WIPREOT amRet
Incoming Ceff Ros Send Calles 10 Neew
% Directoey 10) Intermational Prefoe w0
Time Profde (0
+ W P Route 01) Country Code Redirect and Transfer
&8 Account Code (0) ! S sed REFER A
W License (27) Name Prionty Systern Defauk = ncoming Supervised REFER lever
: ‘f‘ ':;‘J‘ :“‘if‘"‘ ) Description Dutgoing Supervised REFER Never
55 Locstion [0 Send 302 Moved Temporardy
W —'-LIA!PP'_-rvuﬂ-m Coc Dutgoing Blind REFER
W PO EXP210
% System (1)
¥ T4 Line (3)
Control Urst 4) Help
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Select the Transport tab and enter the following information.

e The ITSP Proxy Address is set to the internal interface of Avaya SBCE.
e Layer 4 Protocol is set to TLS.

e Send Port is set to the port number of IP Office, 5061.

e Use Network Topology Info parameter is set to LAN 2. This associates the SIP Line with

the parameters in the System - LAN2 - Network Topology tab.
e Other parameters retain default values in the screen below.
e Click OK.

=% IPOSE VML i
System (1)

SIP Line| Transport SIP URI|VolP  [SIP Credentials|SIP Advanced | Engineering

%23 IPOSE VM1 ITSP Proxy Address 101097176
Line (5)
g 1 : :
-y, 9 Network Configuration
- 10 Layer 4 Protocol ’TLS v] Send Port 5061
..... " y 11
Ly 19 Use Network Topology Info ’LAN 2 '] 5061
[ Control Unit (8)
- Extension (22) Explicit DNS Server(s) 0 0 0 0 0 0 0 0

E-§  User (22)

..... ﬂ Group (0)

-8 Short Code (58)
----- @ Service (0]

-4 Incoming Call Rot
Directory (0)

! Tirne Profile (0)

IP Route (1)

----- Bl Account Code (0)
----- W License (27)
-§5 User Rights (9)
- ARS (1)

""" 5@ Location (0)

----- m Authorization Coc
=% IPQ EXP210

m

Calls Route via Registrar

Separate Registrar

[ System (1) -

! OK
I b

|| Cancel |[ Help
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A SIP Credentials entry must be created for SIP trunking registration and Digest Authentication that
are used by Intermedia SIP trunking service to authenticate calls from the enterprise to the PSTN. To
create a SIP Credentials entry, first select the SIP Credentials tab. Click the Add button and the
New Channel area will appear at the bottom of the pane. To edit an existing entry, click an entry in
the list at the top, and click the Edit... button. In the bottom of the screen, the Edit Channel area will
be opened. In the example screen below, a previously configured entry is edited. The entry was
created with the parameters shown below:
e Set User name and Authentication Name to the value provided by the service provider.
e Set Password and Confirmed Password to the value provided by the service provider.
e The Expiry (mins) is set to 10 minutes in this case as service provider relies on registration
from enterprise to keep the trunk alive.
e Check the Registration required option. Service provider requires registration for Digest
Authentication.
e Click OK.

- POSE VML * | [siP Line| Transport| siP URI|VolP | SIP Credentials |Sip Advanced | Engineering|

-3 System (1)
Ly IPOSE VML Index  UserMame Authentication Mame Contact Expiry (mins) Register Add...

1 Line (3) 1 dgwsidl69411  dgwsid169411 10 True
------ g, 1 Remaove

", 10 Edit...

- Edit S5IP Credentials

=+ Control Unit (8) -
-4 Extension (22) User name dgwsidl69411
H-§  User (22 -

_____ % Grou; (3) Authentication Name dgwsidl63411
-8 Short Code (58)
----- @ Service (0)

[]---@ Incoming Call Re Password sssssssssssssss
----- @m Directory ()

----- £ Time Profile (0) | Confirm Password sessssssssssnee
-l IP Route (1)

----- @l Account Code (0 Expiry (mins) 10 =
----- & License (27)
[]...n , User Rights (9) Registration required i
"¢ ARS (1)

----- B& Location @

e @ Autherization Cc =~
L] 2

Contact
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A SIP URI entry Channel 1 is created to match incoming numbers that IP Office will accept on this
line. Select the SIP URI tab, then click the Add button and then New Channel area will appear at
the bottom of the pane. To edit an existing entry, click an entry in the list at the top, and click the
Edit... button. In the example screen below, a previously configured entry is edited. For the
compliance test, a single SIP URI entry was created that matched any DID number assigned to an IP

Office user. The entry was created with the parameters shown below:

e Via field is pre-populated by IP Office.

e Set Local URI, Contact and Display Name to Use Internal Data. This setting allows calls

on this line which SIP URI matches the number set in the SIP tab of any User as shown in

Section 5.7.

e PAI field is set to None.
e For Registration, select the account credentials previously configured on the line's SIP
Credentials tab.

e Associate this line with an incoming line group in the Incoming Group field. This line
group number will be used in defining incoming call routes for this line. Similarly, associate

the line to an outgoing line group using the Outgoing Group field. For the compliance test, a

new incoming and outgoing group 19 was defined that only contains this line (line 19).

e Set Max Calls per Channel to the number of simultaneous SIP calls that are allowed using

this SIP URI pattern.
e Other parameters retain default values and or set according customer requirements.

e Click OK.

- & BOOTP(3) -

-4 Operator (3)

=-#% Solution

E-§  User(37)

----- % Group(0)

[£-B% Short Code(d5)
----- 25 Directory(0)

£ Time Profile(0)
----- B Account Code(D)
-5 User Rights(a)

""" i@ Location(0)

-+ Contrel Unit (8)
48 Extension (22)
@ User (22)

(- Incoming Call Re
----- 2% Directory (0)

----- 71 Time Profile (0)
-l 1P Route (1)

----- am Account Code (0
----- % License (27)
#-§iy User Rights (9)
- ARS (1)

----- &5 Location (0)

|SIP LinelTransport| 5P URI |‘u"oIP |SIP Credentials | SIP Advanced | Engineering

Channel Groups

2 19 19

Edit Channel
Via

Local URI
Contact

Display Mame
PAI

Registration
Incoming Group

Outgeing Group

Max Calls per Channel

Via Leocal URI Contact Display Name PAI Credential Max Calls

1. 206686..

10.10.87.210

Use Internal Data

Use Internal Data

Use Internal Data

Mone

1: dgwsid169411

19

19

10 =

Add...

Remove

Edit...

II
tal

Cancel

m

----- %% Authorization Cc ™ Help
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SIP URI entry Channel 2 was similarly created for incoming calls appropriately to pre-defined DID
numbers, which is provided by service provider, to access to Feature Name Extension 00 (FNEQO).
The Short Codes for FNEOO are defined in Section 5.6 to provide Dial Tone and Mobile Callback

for mobility extension.

The Channel 2, as shown in the screenshot below, was configured with following parameters.

-7 Time Profile(0)
----- | Account Code(0)
#-fg User Rights(9)

""" &% Location(0)
-39 IPOSE VML

B> Control Unit (8)
-4 Extension (22)
E-§ User (22)

(-3 Incoming Call Rou
----- #m Directory (0)

-7 Time Profile (0)
[+-Jill IP Route (1)

----- Bl Account Code (D)
----- % License (27)

[-f5 User Rights (9)
B ARS (1)

----- & Location (0)

m

Edit Channel

Via

Local URI
Contact

Display Mame
PAI

Registration
Incoming Group

Outgeing Group

Max Calls per Channel

10.10.97.210

2066860216 v

Use Internal Data -

Use Internal Data -

Mone -

1: dgwsidl163411 -

19

19

10 =

e Via field is pre-populated by IP Office.
e Set the Local URI to pre-define DID number appropriately for Channel 2.
e Set Contact and Display Name to Use Internal Data.
e PAI field is set to None.
e For Registration, select the account credentials previously configured on the lines SIP
Credentials tab.
e Associate Incoming Group and Outgoing Group to SIP Line 19.
e Set the Max Calls per Channel field to 10.
e Other parameters retain default values and or set according customer requirements.
e Click OK.
K ggg:i’o%) * | |51 Line| Transport| SIP URI VoIP | SIP Credentials|SIP Advanced | Engineering
427 Solution Channel Groups Via Local URI Contact Display Name PAI Credential Max Calls Add... i
w-§ User3?) 1 19 19 1. N.. 1:dgwsi. 10
----- ik Group(0) Remove
[-8% Short Code(45)
----- == Directory(0) Edit...

m

Cancel

= gﬂ”f\uthorization Cord i
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Select the VoI P tab to set the VVoice over Internet Protocol parameters of the SIP line. Set the

parameters as shown below:

e The Codec Selection can be selected by choosing Custom from the pull-down menu,
allowing an explicit ordered list of codecs to be specified.

e Selecting G.711 ULAW and G.729 codec supported by the Intermedia SIP Trunking service,
in the Session Description Protocol (SDP) offer.

e Set Fax Transport Support to G.711 from the pull-down menu (T.38 faxing is not currently
supported by service provider).

e Set the DTMF Support field to RFC2833/RFT4733 from the pull-down menu. This directs

IP Office to send DTMF tones using SRTP events messages as defined in RFC2833.

Uncheck the VolP Silence Suppression box.

Check the Re-invite Supported box.

Check the PRACK/100rel Supported box.

Set Media Security to Enforce to ensure the use of SRTP for media communicating over the

SIP trunk.

e The Advanced Media Security Options, uncheck the Same As System box to disassociate
the media security settings of the SIP trunk from the media security settings of the system.
Note that what is set here will over write the system and extensions settings in term of media
security.

e The Encryption, check the RTCP box.

e The Crypto Suits, uncheck the SRTP_AES _CM_128 SHA1 80 box as service provider
using only SRTP_AES CM_128 SHALl 32.

e Default values may be used for all other parameters.

e Click OK.
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The VoIP tab capture is shown below.

Groupi0)
o9 Short Codedds)
“u Directory()
£ Time Profile(d)
&m Account Code(D)
- i User Rights(S)
B Location(D)
=% POSE VML
5 0 System (1)
“¥ POSE VW1
= -T4 Lne {5)
-1
9
. 10
- i
- 19 E
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i1 4 Extersion {22)
& User 22)
Group [0}
(2 9% Shoet Code (58
Service 0)
o) Incormng Call
#u Directory ()
71 Time Profile 0
= W P Route )
& Account Code
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514 User Rights (8]
& ¢ ARS (1)
5% Location (0)
2 Authorization ¢
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49 System 1) =
311 Lne 3)
(8 <= Control Unit (4
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w§ Userth
2 Group 1)
[ #% Short Code (65
D service ()
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i+ €D Incoming Call _

JRTIET TE
1 .

3

= | 5 Lnve] Transport| 530 URS VolP  |SIP Credentish | S Advanced|Enginesring
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Fax Transport Support | G711
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G711 ULAW 64K
G729(a) 8K CS-ACELP
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"1 Codec Lockdown
" Allow Diect Medka Path
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|4 PRACK/100re! Supported
[T 611 Fac ECAN

OTMF Suppent | RECZBIIRFCATI

Media Security | Enforce

Advanced Medis Security Options
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Authentication
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5.6. Short Code

Define a short code to route outbound traffic to the SIP line. To create a short code, select Short
Code in the left Navigation Pane, then right-click in the Group Pane and select New. On the Short
Code tab in the Details Pane, configure the parameters for the new short code to be created. The
screen below shows the details of the previously administered “6N;” short code used in the test
configuration.

e Inthe Code field, enter the dial string which will trigger this short code, followed by a semi-
colon. In this case, 6N, this short code will be invoked when the user dials 6 followed by any
number.

e Set Feature to Dial. This is the action that the short code will perform.

e Set Telephone Number to the value shown in the capture bellow. This field is used to
construct the Request URI and To headers in the outgoing SIP INVITE message. The value
N represents the number dialed by the user. The host part following the “@” is the domain of
the service provider network.

e Setthe Line Group Id to the outgoing line group number defined on the SIP URI tab on the
SIP Line in Section 5.5. This short code will use this line group when placing the outbound
call.

e Select United State (US English) for Locale.

e Others parameters are at default values.

e Click OK.
- & BOOTP (3) » | Code “1|| Short Code
% Operator (3) P51
=I5 Solution Code 6N;
X +52 -
----- § User3n) s
..... ,ﬂ Groupi(0) 537N Feature Dial -
8% Short Code(45) 9755 py i
Directory(0) U 5T NE Telephone Number N"@interop-ex.sea.accessline
0 Ti i *hJ
e Eme Prlt32|E£IUJG P66 NE Line Group ID 19 M
. ccou_n ode(0) B FT0NE
""" §3 User Rights(9) BXT1NE Locale |United States (US English) ~
----- i@ Location(0) '
)53 IPOSE VML | | Bwag; Force Account Code ]
"“: S}rstem 1) 224N Force Authorization Code [
-9 Line (5) %3333
- Contro_l Unit (8) BX3N:
4 Extension (22) BXA5N;
@ User (22)
,“ Group (0) I a6N:
@) Short Code (58) BTN
- Service (0) RGN
e Incoming Call Route (] BTN
--a¥m Directory (0] ) =
-7 Time Profile (0) BN
—ll 1P Route (1) PO2N;
-8l Account Code (0] BMaN
B License (27) 8% FNEOD —
ﬁ 3 User Rights (9) - 2
1 b 4 L =
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For incoming calls from mobility extension to FNE features hosted by IP Office to provide Dial
Tone functionality, Short Code FNEOO was created. The FNEOO was configured with the following
parameters.

¢ Inthe Code field, enter the FNE feature code as FNEOO for Dial Tone.

e Set the Feature field to FNE Service.

e Set the Telephone Number field to 0.

e Setthe Line Group ID field to 0.
e Select United State (US English) for Locale.
e Retain default values for other fields.
e Click OK.
BOOTP (5) + | Code “ ||| Short Code
# QOperator (3) 51
-3 Solution . Code FNEQO
~@  User(37) “*52*
# Group(0) P53 N2 Feature FME Service -
@ Short Codel45) X755
-4 Directory(0) PR *57FNE Telephone Number 0
£ Time Profile(0) PR 66N .
-l Account Code(D) BRTONE Line Group ID 0 M
&3 User Rights(9) XTI Lecale | United States (US English) +
- Location(D)
=37 IPOSE VML 5 Bx*99; Force Account Code ]
= S?rstem @ BX2UN; Force Authorization Code [
T4 Line (5) %3333
“2r Control Unit (8) X 3N
-4 Extension (22) "
a User (22) B 45N;
@ Group (0) IR AGN:
-@% Short Code (58) BRATN;
@B Service (0) xeN;
- @Incoming Call Route (] PRTN:
448 Directory (0} ) E
£ Tirme Profile (0) || BxeN,
il IP Route (1) PX92N;
-l Account Code (0) PxIN
-8 License (27) L2 Feoo (I
. a; Urs:_r Rights (3] ' - L , - Help
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5.7. User

Configure the SIP parameters for each user that will be placing and receiving calls via the SIP line

defined in Section 5.5. To configure these settings, first select User in the left Navigation Pane, then
select the name of the user to be modified in the center Group Pane. In the example below, the name
of the user is “H323-Int2550”. Select the SIP tab in the Details Pane.

The values entered for the SIP Name and Contact fields are used as the user part of the SIP URI in
the From header for outgoing SIP trunk calls. They also allow matching of the SIP URI for incoming
calls without having to enter this number as an explicit SIP URI for the SIP line (Section 5.5). The
example below shows the settings for user H323- Int2550.
e The SIP Name and Contact are set to one of the DID numbers assigned to the enterprise
from service provider.
e The SIP Display Name (Alias) parameter can optionally be configured with a descriptive

name.

e If all calls involving this user and a SIP Line should be considered private, then the
Anonymous box may be checked to withhold the user’s information from the network.

e Click OK.

BOOTP (5)

4% Operator (3)

—|-#%9 Solution

----- §  User(am

..... .u Group(0)

----- X% Short Code(45)
--a¥s Directory(0)

----- 17 Time Profile(0)
----- m Account Code(D)
----- §5 User Rights(9)

Name

§-4307

§-Algo 8028
§-Algosizs

§+ Algo 8180 Pag
£+ Algo 8180 Rin
§ Algo 8188 Lou
§- Algo 8188 Pag

Voice Recording | Button Programming | Menu Programming | Mobilityl Group Membership|

User |Voicemai| | DD | Short Codes | Source Mumbers | Telephony | Forwarding | Dial In |

SIP Name 2066864943
SIP Diisplay Mame (Alias) H323-Int25330

Contact 2066864943

----- G5 Location(D) =HA|g0 8301
-39 IPOSE VML _|| & Algo83o1 P
-5 System (1) " | - Bxtna300 [C] Anonymous |
----- 17 Line (5) freansznl |2 3
----- “ Control Unit (8)| || & F4na302 r
----- & Extension (22)
_____ § User22) £ Extn4303
..... % Group (0) £ Extna304
----- 9% Short Code (58)| | | B Extn4305
----- B Service (0) §-H323 3501
""" e Incoming Call F &HHBB—Intl'SSU
-8 Directory (0} _
----- £ Time Profile (0) §r HB23-Int2551
----- A 1P Route (1) g NoUser -
----- il Account Code | ="'SIP'I"t2552 4 1 3
----- % License (27) =HSIP—Int2553
----- § UserRights (@) ~ - ’ - m
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One of the H.323 IP Phones at the enterprise site uses the Mobile Twinning feature. The following
screen shows the Mobility tab for User H323- Int2550.
e The Mobility Features and Mobile Twinning boxes are checked.
e The Twinned Mobile Number field is configured with the number to dial to reach the
twinned mobile telephone, in this case 66139675205.
e Make sure the Mobile Call Control box is checked.
e Other options can be set according to customer requirements.

e Click OK.
‘F BOOTP (3) e User | Voicemail | DMND | Short Codes | Source Mumbers | Telephony | Forwarding | Dial In |
i# Operator (3) §r3500
|=-%22 Solution Announcements | SIP | Personal Directory | Web Self-Administration
- $-a307 -
% User(37) ﬂHAIgo 8028 Voice Recording | Button Programming | Menu Programming | Maobility | Group Membership |
iyl Group(0) "
@ Short Code(45) f-Algosi2s [T] Internal Twinning -
r“‘l\ Directory(0) §+ Algo 8180 Page <Nones
k1 Time Profile(0) a"'ﬁdgo 8180 Ring
Accou.nt Code(0) ﬁ"'AlgD 8188 Loud 1
ﬁ‘. User Rights(9)
i Twin Bridge Appearances
G5 Location(0) & Algo 8188 Page ge App
5= Algo 8301
-0 IPOSE VML aﬁ g0 Twin Coverage Appearances
55 System (1) §rAigos301p
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----- o S o g I g ettt _
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oo TimeProfile @) g o3 1izsst
----- [l 1P Route (1) -n ) =
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&3 User Rights (9) _
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5.8. Incoming Call Route

An incoming call route maps an inbound DID number on a specific line to an internal extension.
This procedure should be repeated for each DID number provided by the service provider. To create
an incoming call route, select Incoming Call Route in the left Navigation Pane, then right-click in
the center Group Pane and select New. On the Standard tab of the Details Pane, enter the
parameters as shown below:

e Set the Bearer Capability to Any Voice.

e Setthe Line Group Id to the incoming line group of the SIP line defined in Section 5.5.
e Set the Incoming Number to the incoming number on which this route should match.

e Select United States (US English) for Locale.

e Default values can be used for all other fields.

e Click OK.
BOOTP (5) » | Line GroupID  Incoming N ||/ Standard || Vaice Recording | Destinations|
Operator () @10 s139675203 |||
=0 Solution em
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B Short Code(45) @10 2066860218 || | ine Group ID 19 -
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L7 Time Profile(0) @19 2066864936 || Incoming Numnber 2066864943
-l Account Code(0)
n ; User Rights(9) @19 AbrElBE Incoming Sub Address
i@ Location(0) I ina CLI
-2 IPOSE WML L neeming
- S?,rstem i1 Locale Iunited States (US English) "l
-4 Line (5)
=+ Control Unit (8) Priority ’1 - Low ']
-4 Extension (22)
% User (22) Tag
iy Group (0)
- @¥ Short Code (58) Hold Music Source [System Source vl
@ Service (0)

@ Incoming Call Route (7)
a4 Directory (0)
-7 Time Profile (0)
-l IP Route (1)
-l Account Code (0]
-y License (27)

Ring Tene Override

MNone

= 0 User:rRights ) = » m
QT; Reviewed: Solution & Interoperability Test Lab Application Notes 26 of 57
SPOC 7/12/2016 ©2016 Avaya Inc. All Rights Reserved. IMTLSIPO91SBCE7




On the Destinations tab, select the destination extension from the pull-down menu of the
Destination field. In this example, incoming calls to 2066864943 on line 19 are routed to extension

4000. Click OK.

-~ & BOOTP (3)
# Operator (3)
' Solution
B User(37)
ﬂ Group(0)
- @% Short Code(45)
- Directory(0)
-7 Time Profile(0)
-l Account Code(0)
-§3 User Rights(9)
B Location(0)
=145 IPOSE WML
-~ ] Sy;tem )
-3 Line (5)

= Control Unit (8)
-4y Extension (22)
@ User(22)
h Group (0)
@ Short Code (58]
@ Service (D)

@ Incoming Call Route (7)
--a4m Directory (0]
-1 Time Profile (0)
-l IP Route (1)

-l Account Code (0)
-y License (27)

-§3 User Rights (9)

b o |3

» | Line GroupID' Incoming N

@10
@10
P11
P19
P19
P19
P19

m

L1

6139675203

5139674301
2066860218
2066860216
2066864936
2066864943

| Standard | Vaice Recording| Destinations |

>

TimeProfile Destination Fallback Extension
Default Value |2550 H323-Int2550 |~ -]

5.9. Save Configuration

Navigate to File = Save Configuration in the menu bar at the top of the screen to save the
configuration performed in the preceding sections.
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5.10. Security Settings

This setting is used with IP telephony endpoints connecting to the system. This setting is used by IP
Office to validate the identity certificate offered by the other end of TLS connection. IP Office does
not support mutual authentication for SIP terminals (an identity certificate is not installed in all SIP
terminals). Therefore, IP Office does not require a client certificate from a SIP terminal, only SIP
and SM trunks. The received certificate is tested as follows:

None: No extra checks are made (The certificate must be in date).

Low: Certificate minimum key size 1024 bits, in date.

Medium: Certificate minimum key size 1024 bits, in date, match to store.

High: Certificate minimum key size 2048 bits, in date, match to store, no self signed, no
reflected, chain validation.

Navigate to File > Advanced - Security - System, choose Certificates tab.

Select Medium for the Received Certificate Checks (Telephony Endpoints).
Click Ok.
Click File > Save Security Settings.

") Avaya IP Office Manager for Server Edition - Security Administration - IPOSE VML [9.1.6.0 build 153] [Administrator] =N =R
Eile Edit View Help
Security Settings System: IPOSE VM1 < | >
=N 'ﬂl Security | System Details | Unzecured Interfaces | Certificates
- General Identity Certificate =
- 1 5 1
;,,,,_,,ftr;é{sévm Cffer Certfficate S
+@ Senvices (7) Cffer |0 Certificate Chain [
+I-4§ Rights Groups (12) —
+h Service Users (6) Signature SHAZ256/RSAZ048
Private Key
lzsued to: 000CZS59DFEAA
Default Subject Name
Subject Atemative Name(s) (1) i
St || View |[ Deete |
[7] Use different Idertity Certificate for Telephony
Received Cedfficate Checks IN _J
{Management Interfaces) one
Received Cedfficate Checks -
{Telephory Endpoints) I Medium vJ
Trusted Certificate Store
Installed Certfficates Avaya SEC Edge
Symartec Class 3 Secure Server CA - G4
VeriSign Class 3 Intemational Server CA - G3
SIP Product Certificate Authority
Add View Delete
QK Cancel Help
]
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6. Configure t Avaya Session Border Controller for Enterprise

This section covers the configuration of Avaya SBCE. It is assumed that the software has already
been installed. For additional information on these configuration tasks, see Section 10.

The compliance testing comprised the configuration for two major components, Trunk Server for the
service provider and Call Server for the enterprise. Each component consists of a set of Global
Profiles, Domain Policies and Device Specific Settings. The configuration was defined in the Avaya
SBCE web user interface as described in the following sections.

Trunk Server configuration elements for the service provider - Intermedia:
e Global Profiles:
o URI Groups
Routing
Topology Hiding
Server Interworking
Signaling Manipulation
o Server Configuration
e Domain Policies:
o Application Rules
o Media Rules
o Signaling Rules
o Endpoint Policy Group
o Session Policy
e Device Specific Settings:
o Network Management
Media Interface
Signaling Interface
End Point Flows - Server Flows
Session Flows

O O O O

@)
©)
@)
©)

Call Server configuration elements for the enterprise - IP Office:
e Global Profiles:
o URI Groups
o Routing
o Topology Hiding
o Server Interworking
o Server Configuration
e Domain Policies:
o Application Rules
o Media Rules
o Signaling Rules
o Endpoint Policy Group
o Session Policy
e Device Specific Settings:
o Network Management

QT; Reviewed: Solution & Interoperability Test Lab Application Notes 29 of 57
SPOC 7/12/2016 ©2016 Avaya Inc. All Rights Reserved. IMTLSIPO91SBCE7



Media Interface

Signaling Interface

End Point Flows = Server Flows
Session Flows

0 O O O

6.1. Log into Avaya Session Border Controller for Enterprise

Use a Web browser to access the Avaya SBCE Web interface, enter https://<ip-addr>/sbc in the
address field of the web browser, where <ip-addr> is the management IP address.

Enter the appropriate credentials then click Log In.

o v o o Log In
Username [

Continue |

Thin aystem s restricted solely 1o authorized users for legtimate
business purposaes only. The actual or attempled unauthorized accens,

use or modifications of this system Is strictly prohibited. Unauthorized
sess'°n Border contr°|ler users are subject to company disciplinary procedures and or criminal
for Enterprlse nnd civil penatties under sinte, tederal or othar applicable domestic and

forelgn laws

The use of thix xystem may be monttorsd wsnd recorded for
ndministrative sand securty resaxons. Anyone accessing this system
expressly consents to such monitoring and recording, and s advised
that If it reveals possible evidence of criminal activity, the svidence of
such activity may be provided to law enforcemaent officials

All usars must comply with all corporate instructions regarding the
protaction of information nssets

© 2011 - 2015 Avaya Inc_All rights reserved

The Dashboard main page will appear as shown below.

Session Border Controller for Enterprise

Dashboard » Dashboard
pemmsraen —
Backup/Restore 03-01-09
01: EMS
System Management 3 System Time AM CDT Refresh
» SBCE
Global Parameters W 7.0.1-03-8739 "
» Global Profiles Fri Jan 15 22-53-12
> PPM Services S8 | Build Date EST2018
> Domain Policies i License State @ 0K e
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6.2. Global Profiles
Global Profiles allows for configuration of parameters across all Avaya SBCE appliances.

The naming convention in this entire section is using as follow:
e SPis stand for Service Provider, which is Intermedia in this case.
e EN is stand for Enterprise Network, which is referred to Avaya IP Office.

6.2.1. Uniform Resource Identifier (URI) Groups

URI Group feature allows user to create any number of logical URI groups that are comprised of
individual SIP subscribers located in that particular domain or group. These groups are used by the
various domain policies to determine which actions (Allow, Block, or Apply Policy) should be used
for a given call flow.

For this configuration testing, “*” is used for all incoming and outgoing traffic.

6.2.2. Server Interworking Profile
Interworking Profile features are configured differently for Call Server and Trunk Server.

To create a Server Interworking profile, select Global Profiles = Server Interworking. Click on
the Add button.

In the compliance testing, two Server Interworking profiles were created for SP and EN respectively.

6.2.2.1 Server Interworking profile for SP
Profile SP-SI was defined to match the specification of SP. The General, Header Manipulations

and Advanced tabs are configured with the following parameters while the other tabs for Timers,
Privacy and URI Manipulation are kept as default.

General tab:

e Hold Support = NONE. Avaya SBCE will not modify the hold/ resume signaling from EN
to SP.

e 18X Handling = None. Avaya SBCE will not handle 18X, it will keep the 18X messages
unchanged from EN to SP.

e Refer Handling = No. Avaya SBCE will not handle REFER. It will keep the REFER
message unchanged from EN to SP.

e T.38 Support = No. SP does not support T.38 fax in the compliance testing.

e Others are left as default values.
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The screenshots below illustrate the Server Interworking profile SP-SI, General.

Session Border Controller for Enterprise AVAYA
Dashboard Interworking Profiles: SP-Si
Administration [add | [iRememei] [ichme:] (ometai]
Backup/Restore —
Systern Management ,’v‘:”” Sierahlu e e obiodsrlaiol
Global Parameters o I’v(mnmul | Timers || Privacy | URS Manipulation | | Headsr Manipulation | | Advanced
+ Global Profiles |
Domain DoS sy .
Server Interworking OCS-Edge-Se Hold Support NONE
Media Forking prrEo 180 Handlng None
Routing — 181 Handiing None
f:;:;‘:::;m" i 182 Handing Nae
Signaling Manipulation OCS FronEn +0 Howkby o
URI Groups e Refer Handling No
SNMP Traps URI Group None
Time of Day Rules S Send Hold No
PPM Services = Delayed Offee No
l:::am Policies ac o g a
Device Specific Settings e Divorsion Header Suppor No
SP-51 Delayed SDP Handling Na
SP4 Re-Imvite Handling No
IPO_%4 Prack Handling No
Allaw 18X SOP No
T.38 Suppon Ne
URS Scheme siP
Via Hepder Format RFC3261
=S
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The screenshots below illustrate the Server Interworking profile SP-SI, Advanced.

Dashboard

IAdministration

Backup/Restare

System Management

> Global Parameters

4 Global Profiles
Domain DoS
Server Interworking
Media Forking
Routing
Server Configuration
Topology Hiding
Signaling Manipulation
URI Groups

Session Border Controller for Enterprise

Interworking Profiles: SP-SI
Add

Interworking

Profiles

Click here to add a description.

AVAYA

’ Rename ” Clone ” Delete ]

General | | Timers | | Privacy | | URI Manipulation | | Header Manipulation | | Advanced L

EN-SI
RC Record Routes Both Sides
ThinkTel Include End Point IP for Context Lookup Mo
Sp_g| Extensions Avaya
sp4 Diversion Manipulation Mo
PO 14 Has Remote SBC Yes

R Route Response on Via Port Mo

SHNMP Traps
Time of Day Rules DTMF Support None
> PPM Services
Diovnain Policios
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6.2.2.2 Server Interworking profile for EN

Profile EN-SI was defined to match the specification of EN. The General and Advanced tabs are
configured with the following parameters while the other settings for Timers, Privacy, URI

Manipulation and Header Manipulation are kept as default.

General tab:

e Hold Support = NONE.
e 18X Handling = None. Avaya SBCE will not handle 18X, it will keep the 18X messages

unchanged from SP to EN.
e Refer Handling = No. Avaya SBCE will not handle REFER, it will keep the REFER

messages unchanged from SP to EN.
e T.38 Support = No. EN does support T.38 fax, but SP doesn’t in the compliance testing.
e Others are left as default values.

The screenshots below illustrate the Server Interworking profile EN-SI, General.

Dashboard
JAdministration
Backup/Restore
System Management
Global Parameters
[+ Global Profiles
Domain DoS
Server Interworking
Media Forking
Routing
Server Configuration
Topology Hiding
Signaling Manipulation
URI Groups
SNMP Traps
Time of Day Rules
PPM Services
* Domain Policies
TLS Management
Device Specific Settings

Session Border Controller for Enterprise

Interworking Profiles: EN-SI

| Add |
Profiles
€s2100
avaya-ru
0OCS-Edge-S
cisco-ccm
cups
Sipera-Halo
OCS-FrontEn
IPO
MTSAllstream
EN-SI
RC
ThinkTel
SP-si

Click here to add & description

General H Timers H Privacy H URI Manipulation I

Header Manipulation l | Advanced |

AVAYA

| Rename || clone || Delete |

Ganeral

Hold Support
180 Handling
181 Handling
182 Handling
183 Handling
Refer Handling
URI Group
Send Hold
Delayed Offer
3xx Handling
Divarsion Header Support
Delayed SDP Handling
Re-Invite Handling
Prack Handling
Allow 18X SDP
T.38 Support
URI Schemea

Via Header Format

NONE
None
None
None

None

RFC3261

| Edit |
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Advanced tab:

e Record Routes = Both Sides. Avaya SBCE will send Record-Route header to both call and
trunk servers.

e Include End Point IP for Context Lookup = No.

e Extensions = Avaya.

e Has Remote SBC = Yes. This setting allows Avaya SBCE to always use the SDP received
from EN for the media.

e DTMF Support = None. Avaya SBCE will send original DTMF method from SP to EN.

e Others are left as default values.

The screenshots below illustrate the Server Interworking profile EN-SI, Advanced.

Session Border Controller for Enterprise AVAYA
Dashboard Interworking Profiles: EN-SI
Administration Add ’ Rename ] ’ Clone ] ’ Delete ]
Backup/Restore
Interworki Click here to sscription.
Systemn Management 'gr;;;;cgr ing Click here to add a description
> Global Parameters General || Timers | | Privacy | | URI Manipulation | | Header Manipulation | | Advanced
cs2100

4 Global Profiles

Domain DoS avaya-ru Record Routes Both Sides

Server Interworking 0OCS-Edge-S... Include End Point IP for Context Lookup Mo

Media Forking cisco-cem Extensions Avaya

Routing cups Diversion Manipulation No

Server Configuration

o . Has Remote SBC Yes

Topology Hiding Sipera-Halo

Signaling Manipulation OCS-FrontEn. . Route Response on Via Port No

URI Groups PO S

SNMP Traps

DTMF S rt N

Time of Day Rules MTSAllstream uppo one

* PPM Services EN-SI

6.2.3. Server Configuration

Server Configuration screen contains four tabs: General, Authentication, Heartbeat, and
Advanced. These tabs are used to configure and manage various SIP Call Server specific parameters
such as TCP, UDP or TLS port assignments, heartbeat signaling parameters, DoS security statistics
and trusted domains.

To create a Server Configuration entry, select Global Profiles > Server Configuration. Click on
the Add button.

In the compliance testing, two separate Server Configurations were created, server entry SP-SC for
SP and server entry EN-SC for EN.

6.2.3.1 Server Configuration for SP

Server Configuration named SP-SC was created for SP. It will be discussed in detail below.
General and Advanced tabs are provisioned for SP on the SIP trunk for every outbound call from
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enterprise to PSTN. The Authentication is disabled to allow IP Office to send out authentication to
SP. Heartbeat tab is kept as disabled as default to allow Avaya SBCE to forward the OPTIONS
heartbeat from EN to SP to query the status of the SIP trunk.

General tab:
Click on the Edit button and enter following information.
e Set Server Type for SP as Trunk Server.
e In the compliance testing, SP supported TLS and listened on port 5061.

Session Border Controller for Enterprise AVAYA
System Management Server Configuration: SP-SC
* Global Parameters Add [ Rename H Clone H Delete ]
14 Global Profiles
) Server Profiles General | | Authentication | | Heartbeat | | Advanced |

Domain DoS

Server Interworking IO Server Type Trunk Server

Media Forking EN-SC

. IP Address / FQDMN Transport
Routing SP.§C
Server Configuration 192.168.122.44 506 s
PO 42

Advanced tab:

Click on the Edit button and enter following information.
e Interworking Profile drop down list, select SP-SI as defined in Section 6.2.2.
e The other settings are kept as default.

Session Border Controller for Enterprise AVAYA
Dashboard Server Configuration: SP-SC
Administration Add ’ Rename ] ’ Clone ] ’ Delete ]
Backup/Restore
Server Profiles General | | Authentication | | Heartbeat || Advanced |
System Management
; PO
Global Parameters Enable DoS Protection (]

< Global Profiles EN-SC

Domain DoS A Enable Grooming [

Server Interworking Interworking Prafile SP-8l

) A ThinkTel
Media Forking TLS Client Profile None
i SP-SC
Routing Signaling Manipulation Script None
Server Configuration
- PO_42 Connection Type SUBID

Topology Hiding P4

Signaling Manipulation Securable (|

URI Groups ORLE

SRAD Tranc :

6.2.3.2 Server Configuration for EN

Server Configuration named EN-SC created for EN is discussed in detail below. General and
Advanced tabs are provisioned but no configuration is done for Authentication tab. The Heartbeat
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tab is kept as disabled as default to allow Avaya SBCE to forward the OPTIONS heartbeat from SP
to EN to query the status of the SIP trunk.

General tab:
Click on the Edit button then specify the following.
e Server Type for EN as Call Server.
e |P Address/[FQDN is IP Office IP address.
e Transport, the link between Avaya SBCE and EN was TLS. Listening on Port 5061.

Session Border Controller for Enterprise AVAYA
Systemn Management Server Configuration: EN-SC
> Global Parameters Add ’ Rename ” Clone H Delete ]
1 Global Profiles
) Server Profiles General | | Authentication | | Heartbeat | | Advanced |

Domain DoS

Server Interworking PO Server Type Call Server

Media Forking EN-5C

. IP Address / FQDN Transport

Routing RC

Server Configuration 10.10.97.210 5061 s

Topology Hiding ThinkTel -

Edit

Advanced tab:
Click on the Edit button to enter the following information.
e Interworking Profile drop down list select EN-SI as defined in Section Error! Reference
source not found..
e Signaling Manipulation Script drop down list select None.
e The other settings are kept as default.

Session Border Controller for Enterprise AVAYA
Dashboard Server Configuration: EN-SC
Administration Add [ Rename ] [ Clone ] [ Delete ]
Backup/Restore
Server Profiles General | | Authentication || Heartbeat | | Advanced |
System Management
s IPO
Global Parameters Enable DoS Protection ]
4 Global Profiles EN-5C
) Enable Grooming [
Domain DoS RC
Server Interworking Interworking Profile EN-SI
) . ThinkTel
Media Forking TLS Client Profile Mone
i SP-5C
Routing Signaling Manipulation Script Naone
Server Configuration
. PO_42 Connection Type SUBID
Topology Hiding P4
Signaling Manipulation Securable ]
URI Groups EROREE -
SNMP Traps
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6.2.4. Routing Profiles

Routing profiles define a specific set of packet routing criteria that are used in conjunction with other
types of domain policies to identify a particular call flow and thereby ascertain which security
features will be applied to those packets. Parameters defined by Routing profiles include packet
transport settings, name server addresses and resolution methods, next hop routing information and
packet transport types.

To create a Routing profile, select Global Profiles & Routing then click on the Add button.

In the compliance testing, Routing profile SP-RP was created to be used in conjunction with Server
Flow (see Section 6.4.4) defined for EN. This entry is to route outgoing calls from the enterprise to
SP.

In the opposite direction, Routing profile EN-RP was created to be used in conjunction with Server
Flow (see Section 6.4.4) defined for SP. This entry is to route incoming calls from SP to the EN.

6.2.4.1 Routing Profile for SP

The screenshot below illustrate the routing profile from Avaya SBCE to the SP network, Global
Profiles & Routing: SP-RP. As shown in Figure 1, the SP SIP trunk is connected with
transportation protocol TLS. If there is a match in the “To” or “Request URI” headers with the URI
Group SP defined in Section Error! Reference source not found., the call will be routed to the Next
Hop Address which is the IP address of SP SIP trunk.

Session Border Controller for Enterprise AVAYA

Dashboard Routing Profiles: SP-RP
Administration

Add Rename ” Clone ” Delete ]

Backup/Restore

System Management Routing Profiles Click here to add a description.
* Global Parameters LT Routing Profile
# Global Profiles To_IPO_MTS
o Profles. -Pe-
oman o EfRP URI  Timeof Load Next H
- . ime of oal e op
Server Interworking Ta RC Priority Group  Day Balancing Address
Media Forking -
Routing SP-RP 1 * default Priority 192.168.122.44 LS Edit Delete
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6.2.4.2 Routing Profile for EN

The Routing Profile for SP to EN, SP-to-EN, was defined to route call where the “To” header
matches the URI Group SP defined in Section Error! Reference source not found. to Next Hop
Address which is the IP address of IP Office as a destination. As shown in Figure 1, the SIP trunk
between EN and Avaya SBCE is connected with transportation protocol TLS.

Dashboard
Administration
Backup/Restore
[System Management

Session Border Controller for Enterprise

Routing Profiles: EN-RP

Routing Profiles

Add

Click here to add a description.

AVAYA

Rename ” Clone ” Delete ]

" Global Parameters 1L Routing Profile
 Global Profiles To_IPO_MTS
paPrones
om0 EN-RP URI  Timeof Load Next H
- Vi erit u Ime o oal Next nop e
Server Interworking o RC Priority Group | Day Balancng Address Transport
Media Forking -
Routing SP-RP 1 * default Priarity 10.10.97.210 TS Edit Delete
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6.2.5. Topology Hiding

Topology Hiding is a security feature of Avaya SBCE which allows changing certain key SIP
message parameters to ‘hide’ or ‘mask’ how the enterprise network may appear to an unauthorized
or malicious user.

To create a Topology Hiding profile, select Global Profiles > Topology Hiding then click on the
Add Profile (not shown).

In the compliance testing, two Topology Hiding profiles were created: SP-TH and EN-TH.

6.2.5.1 Topology Hiding Profile for SP

Topology Hiding profile SP-TH was defined for outgoing calls to SP to:
e Mask URI-Host of the “Request-Line” and “To” headers with service provider SIP domain to
meet the requirements of SP.
e Mask URI-Host of the “From” header to SP SIP domain as shown in capture below.

This implementation is to secure the enterprise network topology and also to meet the SIP
requirements from the service provider.

The screenshots below illustrate the Topology Hiding profile SP-TH.

Session Border Controller for Enterprise AVAYA
Dashboard Topology Hiding Profiles: SP-TH
Adminisiration Add Rename ” Clone ” Delete ]
Backup/Restore
System Management 'I';c;ﬁicirllsrgy Hiding Click here to add a description.
* Global Parameters default Topology Hiding
4 Global Profiles
Domain DoS cisco_th_profile Header Criteria Replace Action Cwverwrite Value
Server Interworking To IPO Referred-By IP/Domain Auto —
Media Forkin : - interop-
Fout g EN-TH To IP/Domain Crverwrite ex sea accessline.com
outing
Server Configuration To RC Refer-To IP/Domain Auto —
Topology Hiding To_ThinkTel Request-Line IP/Domain Ovenwrite Ln)‘:es:gg—accessline com
Signaling Manipulation SP_TH
) . interop-
URI Groups To_IPO_42 From IP/Domain COwverwrite ex sea accessline.com
SNMP Traps
P To SP4 Record-Route IP/Domain Auto -
Time of Day Rules -
. PPM Services From_IPO_14 Via IP/Domain Auto -
> Domain Policies SDP IP/Domain Auto =
; TLS. Management .
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6.2.5.2 Topology Hiding Profile for EN

Topology Hiding profile EN-TH was defined for incoming calls to IP Office to:
e Mask URI-Host of the “Request-Line”, “To”, and “From” headers with the enterprise SIP

domain.

e |eave the “Record-Route”, “Via” headers and SDP to default Auto.

The screenshots below illustrate the Topology Hiding profile EN-TH.

Dashboard
Administration
Backup/Restore

System Management

Session Border Controller for Enterprise AVAYA

Topology Hiding Profiles: EN-TH

Add

lepl:lh:lgy Hidil"lg

Profiles

Rename H Clone ” Delete ]

Click here to add a description.

> Global Parameters default Topology Hiding
4 Global Profiles
Domain DoS cisco_th_profile Header Criteria Replace Action Crverwrite Value
Server Interworking To IPO Referred-By |IP/Domain Auto —
Media Forkin : - interop-
. g EN-TH To IP/Domain Crverwrite ex sea.accessline.com
Routing
Server Configuration To RC Refer-To IP/Domain Auto -
Topology Hiding To_ThinkTel Request-Line IP/Domain Qverwrite gesrgg_accessline T
Signaling Manipulation SP-TH
’ . interop-
URI Groups To_IPO_42 From IP/Domain Civerwrite % sea.accessline com
SHMP Traps )
To SP4 Record-Route IP/Domain Auto -
Time of Day Rules -
. PPM Senvices From_IPO_14 Via IP/Domain Auto —
> Domain Policies SDP IP/Domain Auto =
> TLS. Management
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6.3. Domain Policies

The Domain Policies feature configures various rule sets (policies) to control unified
communications based upon criteria of communication sessions originating from or terminating at
the enterprise. These criteria can be used to trigger policies which, in turn, activate various security
features of Avaya SBCE security device to aggregate, monitor, control and normalize call flow.
There are default policies available for use, or a custom domain policy can be created.

6.3.1. Application Rules

Application Rules define which types of SIP based Unified Communications (UC) applications
Avaya SBCE security device will protect: voice, video, and/or Instant Messaging (IM). In addition,
user can determine the maximum number of concurrent voice and video sessions the network will
process in order to prevent resource exhaustion.

Select Domain Policies Application Rules from the left side menu as shown below. In the sample
configuration, a single default application rule “default” was used. For field deployment create an
application rule with the concurrent sessions purchased.

6.3.1.1 Application Rule for SP

Clone the Application Rule default with a descriptive name e.g. SP-AR for service provider and
click the Edit button to change value of Maximum Concurrent Sessions and Maximum Session
Per Endpoint to 500 respectively as shown and then click the Finish button (not shown). Others are
left as default.

Session Border Controller for Enterprise AVAYA

Dashboard Application Rules: SP-AR
Idministration

| Add |  Filter By Device... hd | Rename || clone || Delete |
PBackup/Restore . -
System Management Click here to add a description
Global Parameters SPAR Application Rule
Global Profiles &
; \ Sess
PPM Services AR
I Domain Policies EN-AR
Audio v vl 500 500
Application Rules
Border Rules Video l
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6.3.1.2 Application Rule for EN

Similarly, clone the Application Rule default with a descriptive name e.g. EN-AR for IP Office and
click the Edit button to change value of Maximum Concurrent Sessions and Maximum Session
Per Endpoint to 500 respectively as shown and then click the Finish button (not shown). Others are
left as default.

Session Border Controller for Enterprise AVAYA
Dashboard Application Rules: EN-AR
fansnseion [(Add | Filter By Device... v [ Rename | [ Clone | [ Delete |
Backup/Restore
Global Parameters SP-AR Application Rule |
Global Profiles o v
. C ant Sessions
PRI Services AR
4 P
Domain oll'mes EN.AR Aidio M 60 500
Application Rules
Border Rules Video (]
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6.3.2. Media Rules

Media Rules define RTP media packet parameters such as prioritizing encryption techniques and
packet encryption techniques. Together these media related parameters define a strict profile that is
associated with other SIP specific policies to determine how media packets matching these criteria
will be handled by Avaya SBCE security product.

To clone a signaling rule, navigate to Domain Policies > Media Rules, select the default rule then
click on the Clone Rule button (not shown).

In the compliance testing, two Media Rules were created for SP and EN.

6.3.2.1 Media Rule for SP

Clone the Signaling Rule default-low-med with a descriptive name e.g. SP-SRTP-MR and click on
the Finish button (not shown). Select this newly created rule and click on Edit to modify the
parameters as shown below. Then click on Finish (not shown) again to save the changes.

Session Border Controller for Enterprise AVAYA

Dashboard Media Rules: SP-SRTP-MR

Administration

Add Filter By Device... - [ Rename ” Clone ” Delete ]

Backup/Restore

Media Rules

Click here to escription.
System Management lick here to add a description

* Global Parameters defauit-low-med Media Encryption || Media Silencing | | Media QoS || Media BFCP | | Media FECC |

> Global Profiles default-low-m...
. Audio Encryption
> PPM Services default-high il
- - SRTP_AES CM_128 HMAC SHA1 32
4 Domain Policies _ Preferred Formats SRTP AES CM 128 HMAC SHA1 80
N default-high-enc - - - - - -
Application Rules
Encrypted RTCP
Border Rules avaya-low-me. .. ia @
Media Rules MTSAllstrea. . MKI D
Security Rules — Lifetime Any
Signaling Rules B
. . i Int: ki
End Point Policy ThinkTel MR neneraing =
Groups IPO_MR
1 Viden Eneratio
Session Policies SPMR Video Encryption
> TLS Management Preferred Formats RTP
> Device Specific Settings SRTP-RW Interworking [
RTP-RW
Miscellaneous
SP-SRTP-MR
Capability Negotiation O
EMN-SRTP-MR. e yeg
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6.3.2.2 Mediarule for EN

Clone the Media Rule default-low-med with a descriptive name e.g. EN-SRTP-MR and click on
the Finish button (not shown). Select this newly created rule and click on Edit to modify the
parameters as shown below. Then click on Finish again to save the changes.

Session Border Controller for Enterprise AVAYA

Dashboard Media Rules: EN-SRTP-MR

IAdministration

Add Filter By Device... A ’ Rename ” Clone ” Delete ]
Backup/Restare
System Management Media Rules Click here to add a description.
> Global Parameters defaut-low-med Media Encryption || Media Silencing || Media QoS || Media BFCP || Media FECC |
> Global Profiles default-low-m. . . .
PPl Services CEI-SITE —— SRTP_AES_CM_128_HMAC_SHA1_32
4 Domain Policies Preferred Formats

SRTP_AES_CM_128_HMAC_SHA1_80

— default-high-
Application Rules etault-high-enc

Encrypted RTCP
Border Rules avaya-low-me.... rypt =
Media Rules MTSAllstrea... MK o
Security Rules RC MR Lifetime Any
Signaling Rules B

ThinkTel_MR Interworking

End Point Policy
GrUUpS IPO_MR

) . Video Encryptio
Session Policies SoR RN
> TLS Management Preferred Formats RTP
» Device Specific Settings SRTP-RW Interworking ]
RTP-RW
Miscellaneous
SP-SRTP-MR
Capability Negotiation [
EN-SRTP-MR P v 1ea

6.3.3. Signaling Rules

Signaling Rules define the action to be taken (Allow, Block, Block with Response, etc.) for each
type of SIP-specific signaling request and response message. When SIP signaling packets are
received by Avaya SBCE, they are parsed and “pattern-matched” against the particular signaling
criteria defined by these rules. Packets matching the criteria defined by the Signaling Rules are
tagged for further policy matching.

To clone a signaling rule, navigate to Domain Policies = Signaling Rules, select the default rule
then click on the Clone Rule button (not shown).

In the compliance testing, two Signaling Rules were created for SP and EN.

6.3.3.1 Signaling Rule for SP

Clone the Signaling Rule default with a descriptive name e.g. SP-SR and click on the Finish button
(not shown). Verify that General settings of SP-SR with Inbound and Outbound Request were
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set to Allow, and Enable Content-Type Checks was enabled with Action and Multipart-Action

were set to Allow (not shown).

On the Signaling QoS tab and enter the following information.
e Select the proper Quality of Service (QoS).
e Avaya SBCE can be configured to mark the Differentiated Services Code Point (DSCP) in
the IP packet header with specific values to support Quality of Services policies for

signaling.

The following screen shows the QoS value used for the compliance testing.

Dashboard

JAdministration Add

Backup/Restore

Signaling Rules

System Management
> Global Parameters 5P-SR
[« Domain Palicies

Application Rules

Border Rules

Media Rules

Security Rules

Signaling Rules

el Dleini Dol

Session Border Controller for Enterprise

Signaling Rules: SP-SR

Filter By Device... -

Click here to add a description.

AVAYA

[ Rename ” Clone ” Delete ]

e R s |t e
ucip

Head Signaling QoS
| signating os |

Signaling QoS
QoS Type DSCP
DSCP EF

Edit

6.3.3.2 Signaling Rule for EN

Clone the Signaling Rule default with a descriptive name e.g. EN-SR for EN and click on the
Finish button (not shown). Verify that General settings of EN-SR with Inbound and Outbound
Request were set to Allow, and Enable Content-Type Checks was enabled with Action and
Multipart-Action were set to Allow (not shown). Similarly the Signaling QoS rules are set as

shown in Figure below.

Similarly the Signaling QoS rules are set as shown in Figure below.

Dashboard
Aidministration Add
Backup/Restore

Signaling Rules
[System Management gnaing =ute

Session Border Controller for Enterprise

Signaling Rules: EN-SR

Filter By Device... -

Click here to add a description.

AVAYA

[ Rename ” Clone ][ Delete ]

" Global Parameters EN-SR meTﬂ|D q ||" p ||" q ‘Headers||° p Head || Signali ,-Oos|
. Domain Policies Sp.SR ucip
Application Rules Signaling QoS
Border Rules
Media Rules QoS Type DSCP
Security Rules D3CP EF
Signaling Rules [m
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6.3.4. Endpoint Policy Groups

The rules created within the Domain Policy section are assigned to an Endpoint Policy Group.
The Endpoint Policy Group is then applied to Server Flow defined in Section 6.4.4.

Endpoint Policy Groups were separately created for SP and EN.

To create a policy group, navigate to Domain Policies = Endpoint Policy Groups and click on the
Add Group button (not shown).

6.3.4.1 Endpoint Policy Group for SP

The following screen shows SP-PG created for SP.

Set Application Rule to SP-AR which was created in Section 6.3.1.1.
Set Media Rule to SP-SRTP-MR which was created in Section 6.3.2.1.
Set Signaling Rule to SP-SR which was created in Section 6.3.3.1.

Set Border Rule to default.

Set Security Rule to default-med.

Session Border Controller for Enterprise AVAYA

4 Domain Policies

Policy Groups: SP-PG

Application Rules
Border Rules
Media Rules
Security Rules

Paolicy Groups

[(Add |  Fiter By Device... .

[ Renama | [ clone | [ Delete |

Glick here to add a description

EN-PG By
Hover aver a row to see its description

Signaling Rules SP.PG
End Point Policy Policy Group
s | Summary ]
Session Policies
L TLS Managemem Order Application Border Maodia Security Signaling
" Device Specific Settings 1 SP-AR default SP-SRTP-MR  default-mad SP-5R Edit

6.3.4.2 Endpoint Policy Group for EN
Similarly, the following screen shows policy group EN-PG created for EN.

Session Border Controller for Enterprise

< Domain Palicies
Application Rules
Border Rules
Media Rules
Security Rules
Signaling Rules

End Point Policy
Groups

Session Policies
» TLS Management
» Device Specific Settings

AVAYA

Policy Groups: EN-PG -
Filter By Device... -

Policy Groups

Rename H Clone ][ Delete ]

Click here to add a description.

EN-PG

SP-PG
Policy Group

Hover over a row to see its description.

Crder Application Border Media Security Signaling

1 EN-AR default EN-SRTP-MR  default-med EN-SR Edit
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6.4. Device Specific Settings

The Device Specific Settings feature allows aggregate system information to be viewed and various
device-specific parameters to be managed to determine how a particular device will function when
deployed in the network. Specifically, it gives the ability to define and administer various device-
specific protection features such as Message Sequence Analysis (MSA) functionality and protocol
scrubber rules, end-point and session call flows, as well as the ability to manage system logs and
control security features.

6.4.1. Network Management

The Network Management page is where the network interface settings are configured and enabled.
During the installation process of Avaya SBCE, certain network-specific information is defined
such as device IP address, public IP address, subnet mask, gateway, etc. to interface the device to the
networks. This information populates the various Network Management tabs which can be edited as
needed to optimize device performance and network efficiency.

Navigate to Device Specific Settings = Network Management, under Interfaces tab, enable the
interfaces connecting to the inside enterprise and outside service provider networks. To enable an

interface, click on “Disable” Status. The following screen shows interface Al and B1 were
Enabled.

Session Border Controller for Enterprise AVAYA
Dashboard Network Management: mSBCE
Administration
TLS Management P I l — l
4 Device Specific Settings nterfaces | [iHStuRCN
Network mSBCE | Add vian |
Management
Intarface Name VLAN Tag Status

Media Interface A1
Enablad
Signaling Interface

End Point Flows B1 Enablod

On the Networks tab and verify the IP addresses assigned to the interfaces and that the interfaces
were enabled. The following screen shows the private interface was assigned to Al and the public
interface was assigned to B1 appropriate to the parameters shown in the Figure 1.

Session Border Controller for Enterprise AVAYA
Dashboard Network Management: mSBCE

Global Parameters

st Intorfaces || Networks |

I Domain Policies mSBCE

TLS Management

Gateway Subnet Mask Interface IP Address

+ Device Specific Settings

s Network A1  10.10.97.129 265255256192 A1 10.10.97 176 dit  Dealete
Management
Media Interface Network_B1 10109897 265265266224 B1 1010.98.108  Edit  Dalots
Signaling Interface
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6.4.2. Media Interface

The Media Interface screen is where the media ports are defined. Avaya SBCE will open connection
for RTP traffic on the defined ports.

To create a new Media Interface, navigate to Device Specific Settings = Media Interface and
click on the Add Media Interface button (not shown).

Two separate Media Interfaces are needed for both the inside and outside interfaces. The following
screen shows the Media Interfaces InsideMedia and OutsideMedia were created for the compliance

testing.

Note: After the media interfaces are created, an application restart is necessary before the changes

will take effect.

Dashboard
IAdministration

Session Border Controller for Enterprise AVAYA

Media Interface: mSBCE

Backup/Restare
Devices Media Interface
System Management
N mSBCE
Global Parameters Modifying or deleting an existing media interface will require an application restart before taking
> Global Profiles effect. Application restarts can be issued from System Management.
> PPM Services
> Domain Policies :
> TLS Management m’:d;f”: Port Range
g i - i
Device Spectfic Settings InMedia 10109778 | ey 35000-40000  Edit Delete
Network Management - '
i ; 10.10.98.103 ;
Media Interface OutMedia S 35000 - 40000 Edit Delete
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6.4.3. Signaling Interface

The Signaling Interface screen is where the SIP signaling port is defined. Avaya SBCE will listen for
SIP requests on the defined port.

To create a new Signaling Interface, navigate to Device Specific Settings - Signaling Interface
and click on the Add Signaling Interface button (not shown).

Two separate Signaling Interfaces are needed for both inside and outside interfaces. The following
screen shows the Signaling Interfaces InsideSIP and OutsideSIP were created in the compliance
testing with TLS/5061 and TLS/5061 respectively configured for inside and outside interfaces.

Session Border Controller for Enterprise AVAYA

Dashboard Signaling Interface: mSBCE

Signaling Interface

Modifying or deleting an existing signaling interface will require an application restart before

Administration
Backup/Restore

System Management
> Global Parameters mSBCE
Global Profiles taking effect. Application restarts can be issued from System Management.
> PPM Services

> Domain Policies

=

> TLS Management Signaling IP ;Lft TLS Profile
4 Device Specific Settings
) 10.10.97 176 )
Network Management InsideSIG m’_m (w1, 5060 5060 5061 AwvayaSBCServer Edit Delete
Media Interface
. . . 10.10.98.103 )
Signaling Interface OutsideSIG m:‘_m @1, 5060 5060 5061 AvayaSBCServer Edit Delete
End Point Flows
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6.4.4. End Point Flows - Server Flow

When a packet is received by Avaya SBCE, the content of the packet (IP addresses, URISs, etc.) is
used to determine which flow it matches. Once the flow is determined, the flow points to a policy
which contains several rules concerning processing, privileges, authentication, routing, etc. Once
routing is applied and the destination endpoint is determined, the policies for this destination
endpoint are applied. The context is maintained, so as to be applied to future packets in the same
flow. The following screen illustrates the flow through Avaya SBCE to secure a SIP Trunk call.

*Call Server* — Trunk Server “Trurk
Policy Group iy Flow Server” Policy
el : DD
ow =
; “Call Server”
<] gfﬂlme'
r =

1P-POX

24
]
-
2
2
)
i3
:
SP Trunk Service Provider
V &
-

In the compliance testing, two separate Server Flows were created for SP and EN.

To create a Server Flow, navigate to Device Specific Settings = End Point Flows, select the
Server Flows tab and click on the Add Flow button (not shown). In the new window that appears,
enter the following values while the other fields were kept as default.
e Flow Name: Enter a descriptive name.
e Server Configuration: Select Server Configuration created in Section 6.2.3 which the
Server Flow associates to.
e URI Group: Select “*”.
e Received Interface: Select the Signaling Interface created in Section 6.4.3 which is the
Server Configuration is designed to receive SIP signaling from.
e Signaling Interface: Select the Signaling Interface created in Section 6.4.3 which is the
Server Configuration is designed to send the SIP signaling to.
e Media Interface: Select the Media Interface created in Section 6.4.2 which is the Server
Configuration is designed to send the RTP to.
e End Point Policy Group: Select the End Point Policy Group created in Section 6.3.4.
¢ Routing Profile: Select the Routing Profile created in Section 6.2.4.
e Topology Hiding Profile: Select the Topology Hiding profile created in Section 6.2.5 to
apply toward the Server Configuration.
e Use default values for all remaining fields. Click Finish to save and exit.
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The following screen shows the Server Flow SP-SF for SP.

Edit Flow: SP-SF X

Flow Name SP-SF

Server Configuration SP-5C =

LRI Group * -

Transport * -

FHemote Subnet *

Received Interface InsideSIG -

Signaling Interface OutsideSIG -

Media Interface OutMedia -

End Point Policy Group SP-PG

Routing Profile EN-RFP |ll

Topology Hiding Profile SP-TH -

Signaling Manipulation Script Mone -

Remote Branch Office Any -
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Similarly, the following screen shows the Server Flow EN-SF for EN.

Edit Flow: EN-SF X

Flow Mame

Server Configuration
URI Group

Transport

Remote Subnet
Received Interface
Signaling Interface
Media Interface

End Paint Policy Group
Routing Profile
Topology Hiding Profile
Signaling Manipulation Script

Remote Branch Office

EMN-5F

EM-5C -

OutsideSIG -
InsideSIG -
InMedia -
EM-PG

SP-RP -
EM-TH -
MNone *

Any -
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7. Intermedia SIP Trunking Configuration

Intermedia is responsible for the configuration of Intermedia SIP Trunking service. The customer
will need to provide the IP address used to reach Avaya IP Office at the enterprise, this address will
be the outside interface of Avaya SBCE. Intermedia will provide the customer the necessary
information to configure Avaya IP Office SIP connection to Intermedia. The provided information
from Intermedia includes:

IP address of the Intermedia SIP proxy.

Supported codecs.

DID numbers.

IP addresses and port numbers used for signaling or media through any security devices.

8. Verification Steps
The following steps may be used to verify the configuration:

e Use Avaya IP Office System Status application to verify the state of the SIP connection.
Launch the application from Start = Programs = IP Office = System Status on the PC
where Avaya IP Office Manager was installed. Select the SIP line of interest from the left
pane. On the Status tab in the right pane, verify that the Current State is Idle for each
channel (assuming no active calls at present time).

Status | Utilization Summary Alarms

Line Service State:

Peer Domain Name:

Resolved Address:

Line Mumber:

Mumber of Administered Channels:
Number of Channels in Use:
Administered Compression:

Enable Faststart:

Silence Suppression:

Media Stream:

Layer 4 Protocol:

SIP Trunk Channel Licenses:

SIP Trunk Channel Licenses in Use:
SIP Device Features:

IP Office System Status

SIP Trunk Summary

In Service
avayalab.com
135.10.97.178
19

20

0

G711 Mu

off

off

RTP

uDP

Unlimited

®-
1]

Time in
State

Ide |00:24:32

Transmit Transmit
.. Jitter Packet...

Ide |00:49:27

[ ] »

20:23:27

Ide |20:23:27

1
2
3 Idle
4
5

Ide |20:23:27
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e Select the Alarms tab and verify that no alarms are active on the SIP line.

IP Office System Status

Status  Utiization Summary Alarms

Alarms for Line: 19 SIP avayalab.com

Last Date Of Error Occurrences Error Description

Clear Clear all Graceful Shutdown ] [ Force Qut of Service Print... Save As...

12:47:59 PM Onling )

e Verify that a phone connected to PSTN can successfully place a call to Avaya IP Office with
two-way audio.

e Verify that a phone connected to Avaya IP Office can successfully place a call to the PSTN
with two-way audio.

e Using a network sniffing tool e.g. Wireshark to monitor the SIP signaling between the
enterprise and Intermedia. The sniffer traces are captured at the public interface of Avaya
SBCE.

9. Conclusion

The Intermedia SIP Trunking passed compliance testing. These Application Notes describe the
procedures required to configure the SIP connection between Avaya IP Office, Avaya SBCE and the
Intermedia SIP Trunking service as shown in Figure 1.

QT; Reviewed: Solution & Interoperability Test Lab Application Notes 55 of 57
SPOC 7/12/2016 ©2016 Avaya Inc. All Rights Reserved. IMTLSIPO91SBCE7



10. Additional References

[1] IP Office 9.1 Administering Avaya IP Office Platform with Manager, Release 9.1.0, Issue 10.03,
February 2015.

[2] Administering Avaya IP Office™, Platform Voicemail Pro IP Office™ Platform 9.115-601063,
Issue 10c - (09 December 2014).

[3] / IP Office Embedded Voicemail User Guide (IP Office Mode), Document number 15-604067, Issue
9.0, 10 September 2013.

[4] Avaya Session Border Controller for Enterprise Overview and Specification, Release 7.0, Issue
1, August 2015.

[5] Deploying Avaya Session Border Controller for Enterprise, Release 7.0, Issue 1, August 2015.

[6] Deploying Avaya Session Border Controller in Virtualized Environment, Release 7.0, Issue 1,
August 2015.

[7] Administering Avaya Session Border Controller for Enterprise, Release 7.0, Issue 1, August
2015.

[8] Application Notes for configuring Avaya IP Office 9.0 and Avaya Session Border Controller for
Enterprise 6.3 to support Remote Workers, Issue 1.0.

[9] Using Avaya Communicator for Web, Release 1, Issue 1.0.4, October 2015.

Product documentation for Avaya products may be found at http://support.avaya.com. Additional IP
Office documentation can be found at:
http://marketingtools.avaya.com/knowledgebase/

Product documentation for Intermedia SIP Trunking is available from Intermedia.
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full title name and filename, located in the lower right corner, directly to the Avaya DevConnect
Program at devconnect@avaya.com.
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